Target Drillhole Mapping
The Target system enables you to create a new blank map to fit a defined data range. The data range can be entered
manually, or it can be determined from the range of selected data in a database or from a grid. The Target system includes
several options for selecting holes to include on a map. The methods included in this how-to guide include:
Selecting/deselecting all drillholes
Selecting holes from a list
Selecting holes by name
Selecting holes using the Hole Selection Tool
This how-to guide also walks you through creating several types of maps. The map creation topics in this guide include:
Creating a new map
Creating a base map
Creating a plan map
Creating section and stacked section plots

Selecting Holes
A key requirement for the geologists and geochemists that are evaluating and presenting drillhole data is the ability to select
various combinations of drillholes for optimal visualization and plotting. Selecting holes is also necessary for querying and
creating data, as one may need to interpolate across holes to fix how their data is displayed. The Target system provides a
comprehensive set of options for performing this task. The basic methods of hole selections are listed below.
Selecting (or Deselecting) All Holes: Enables quick development of master plan maps or resetting of drillholes prior to
making new selections.
Selecting Holes by Name or Name Mask: Enables batch selection of multiple holes with systematic drillhole
identifiers. Requires a standard drillhole naming scheme for identifying related holes. For information on Name mask
parameters, click the Help button on the Select holes by name dialog.
Selecting Holes by List: Enables custom selection of single or multiple holes via a list of all the holes in the database.
Requires pre-existing knowledge of holes.
Selecting Holes by Plan map: Enables rapid visual selection of single or multiple holes by using a polygon defining tool
to select holes along regular or irregular sections, on a plan map. Useful for quick evaluation of project data.
Select Holes by Collar table data: Enables custom selection of holes based on values from a channel in the collar
table channel. Once a channel from the collar table has been selected, the two-panel selection tool is displayed with all
the available items which can be selected. Select one or more, and then all holes with corresponding matching values
will be selected.
Select Holes by Polygon File: Enables the selection of holes based on a polygon (PLY) file. This is useful for claims
boundaries, etc.
Select Holes by the Selection Tool: Enables interactive selection of single or multiple holes by area. The Hole
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Selection Tool includes a plan view of the drill survey area as well as display and selection tools.
In addition, the system also enables you to save and load your selections.
Save and/or Load Selections: Enables you to save the current hole selections, or load previous hole selections from a
selection file (*.sel).

Selecting/Deselecting All Drillholes
There are a number of methods available in the Drillhole system to select drillholes. If you want to work with all the drillholes
in your database, or would like to deselect them all, follow the steps below.
To Select All Drillholes
1. On the DH-Plot menu, click Select Holes and then select Select all Holes.
All the drillholes in your drillhole project will be selected.
To Deselect All Drillholes
1. On the DH-Plot menu, click Select Holes and then select Deselect all Holes.
All the drillholes in your drillhole project will be deselected.

Selecting Holes from List
There are a number of methods available in the Drillhole system to select drillholes. This method uses the Select Holes
from List dialog.
To Select Drillholes from List
1. On the DH-Plot menu, click Select Holes and then select Selection Tool.
The Hole Selection Tool will appear.
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2. Using this tool, scroll down through the list of drill holes in the Selected and Not Selected lists and verify that the
correct holes have been selected.
3. Using the arrow buttons select or deselect additional drillholes as needed. Click OK to exit the dialog.

Selecting Holes by Name
There are a variety of methods available in the Drillhole system to select the drillholes. In this example, we will show how to
select drillholes by name or name mask (wild-card characters allowed).
To Select Drillholes by Name
1. On the DH-Plot menu, click Select holes and then select By name or Name Mask.
The Select holes by name dialog will appear.
2. In the Name mask (* and ? accepted) box, specify the hole(s) and using the Select or de-select dropdown list, specify
if you want to select or de-select the data.
3. From the Overwrite or append dropdown list select Overwrite to update the selection state of every hole, based on
whether the hole name matches the name mask. Select Append and only holes matching the input mask will have
their selection state altered, enabling this tool to be used in a cumulative mode.
4. Click OK to select drillholes by name.

Selecting Holes from Plan Map
You will sometimes want to concentrate on an area of focus from a project “Plan” map. This will enable you to display only
the area of the project that is of interest to you.
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To Select Drillholes from Plan Map
1. Make sure your plan map is open and selected in your project.
If you previously selected one or many drillholes, you will need to first deselect all holes by clicking Deselect
all holes.
2. On the DH-Plot menu, click Select Holes.
3. Select From Plan Map. The Define polygon dialog will be displayed.

4. Click the OK button to interactively define a polygon on your map.
5. Using your mouse, define a polygon around the holes in the plan map you wish to select as an area of interest. An
example is shown below:
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6. When finished,right-click and select Done from the popup menu. The system selects the holes within the defined
boundary.

Selecting Holes using the Hole Selection Tool
The Hole Selection Tool enables custom selection of single or multiple holes using a dialog that displays a plan view of the
drillhole project. This tool enables you to view "all holes", "selected holes" and holes including "full traces" or "labels". You
can select interactively by drawing a polygon or by clicking holes individually. This method is best used if you have preexisting knowledge of your drillholes and is an excellent way to preview the locations of your drillhole and the extents of
your drillhole traces.
Selecting Drillholes using the Hole Selection Tool
1. On the DH-Plot menu, click Select Holes and then select Selection Tool.
The Hole Selection Tool will appear.
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2. In the Display section of the dialog, select All holes or Selected holes and select if holes include Full Traces and Hole
Labels.
3. The drillhole plan view area can be modified using the Zoom In button (
Zoom Data Extents button (

), the Zoom Out button (

) and the

).

4. In the Selection Tools section of the dialog you can select the Select All or Select None buttons, or depending on
the Selection Mode you can Select/Deselect single holes (
Select/Deselect using polygon tool (

), Select/Deselect using rectangle tool (

) or

).

5. To deselect all the holes click the Select None button.
6. Set the Selection Mode to Select and using the Select/Deselect buttons described above (single holes, rectangle
tool, polygon tool), select the drillholes. Selected drillholes will be highlighted, while deselected holes will be faded,
as shown below.
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Creating a New Map
Target Can be used to produce an intelligent entity called a Map. Physically a map is a special graphic file (*.MAP)
containing drawings and images. We call the map intelligent because it enables you to edit it interactively, apply dynamic
linking and track the map creation processes.When you create or open a map in Target, the system displays a Map window
in the project. For a new map, the window is initially empty. For an existing map, all map elements are displayed when the
window opens.
An important component of the map is the map template. Templates control placement of base map elements (surrounds),
contours, grids, plots, images and any other graphics elements that you may require in your completed map. For more
information on mapping, map components and working with maps see the Application Help.
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To Create a New Map
1. Select the database you wish to create a map from in your current project.
2. On the Surface Mapping menu, select New map and then select New map from E,N.
The Data range to map dialog appears.

3. Click the Scan data button to have the system query the database for the Minimum X, Y and Maximum X, Y
coordinates, Distance units and the Coordinate System information, or enter the desired data range manually.
If the scanned data or grid file does not have an established unit, "metres" is assumed. It is important that the
distance units accurately reflect the units of the data range. The default unit can be modified from the Default
Settings dialog, found on the GX|Global Settings|Generalmenu.
4. Click the Next> button.
The Create a New Map dialog appears.

5. Enter a Map name. Using the dropdown list, select the Map Template and then click the Scale button.
The system automatically calculates a scale that will fit the data on the map template. It's recommended that you
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increase the scale up to a more appropriate 'round' number (e.g. from 19255 to 20000).
6. Click the Finish button to display the new blank map.

Creating a Base Map
Maps are composed of views. A view is a coordinate translation and a masking region and is used to organise and display
information on a map. Maps consist of a Base view, which uses paper coordinates with an origin at the bottom left corner of
the page, and a Data view, which uses ground coordinates.
You can customize your base map with many elements, including map surround, north arrow, scale bar, reference grids,
latitude/longitude annotations, text blocks/balloons and titles. The layout of your base map can either be map or figure
style. Figure style maps have a layout with the title, scale bar and north arrow located at the bottom of the map, whereas
map style maps have a layout with the title box, scale bar and north arrow along the right hand side of the map. The
following images show the difference in layout between the two styles.

To Create and Plot a Figure Style Base Map
1. Make sure your map file is open and selected in the project.
2. On the Surface Mapping menu, select Base Map and then select Draw Base Map.
The Basemap layout dialog appears.
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This dialog is the first dialog in the base map layout wizard. The type of Map style that you choose here will reflect the
type of dialogs to follow.
For this example, we select the figure style.
3. Select thefigure style.
4. Click Next> to continue.
The Figure style base map dialog appears.
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5. Specify the display characteristics of the base map elements.
For detailed information on each setting, click the Help button.
6. Set the North direction. If blank, no North arrow is drawn.
7. You can specify different types of display styles for the Reference grid via the dropdown list.
8. Configure the other base map options as desired.
9. Click Next> to continue.
The Figure titles dialog box appears.

10. You can specify the map titles and sub-titles, if desired.
11. Click Finish to plot the base map on your current open map.
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To Create and Plot a Map Style Base Map
1. Make sure your map file is open and selected in the project.
2. On the Map Tools menu, select Base Map and then select Draw base map.
The Basemap layout dialog appears.

This dialog box is the first dialog box in the base map layout wizard. The type of Map style that you choose here will
reflect the type of dialog boxes to follow.
For this example, we select the Map style.
3. Select map.
4. Click Next> to continue.
The Full map style base map dialog appears.
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For detailed information on each setting, click the Help button.
5. Set the North direction. If blank, no North arrow is drawn.
6. You can specify different types of display styles for the Reference grid via the dropdown list.
7. Configure the other base map options as desired.
8. When complete, click Next>.
The Map title block dialog appears.
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9. You can specify the map titles and sub-titles, if desired.
10. Click Finish to plot the base map on the current open map.

Creating a Plan Map
Plan maps provide surface views of drillhole collars, co-ordinates, positioning grids, drillhole traces and other information,
such as the title block and a list of the holes. In the Drillhole system, plan maps represent an important organizational and
navigational tool that enables you to quickly display drillhole collars and evaluate drilling progress, display drillhole traces to
help establish subsurface drilling coverage, and construct drillhole sections.
You can replot your Plan map using the Replot Holes on Existing Plan or Section option, from the DH-Plot menu. This
option enables you to regenerate your current Plan (or Section) maps by simply replotting the holes without eliminating any
added groups, such as interpretations, images, or grids.
To Create a Plan Map
1. On the DH-Plot menu, click Plan map.
The Plan Map Parameters dialog will appear.
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2. Fill in the information across the various tabs of this dialog.
For more information on the Plan Map Parameters dialog boxes, click the Help button on the individual tabs.
3. Click OK to generate your plan map. By default the collar locations are plotted using a circle symbol. There are
several parameters available to help you customise the display of your plan map. The following table describes each
tab in the Plan Map Parameters dialog box.
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Tab

Tab Description

Plan Location

Use this tab to specify the location of the plan map.

Collars

Use this tab to select specific symbols for plotting hole collars

Hole Traces

Use this tab to define the hole traces on the plan map

Data

Use this tab to specify the data and plot type for your map.

Reference Grids

Use this tab to specify the parameters for displaying reference grids of local eastings and northings on
the plan map

Plan Grid

Use this tab to plot a plan grid on the map.

Save/Load

Use this tab to load and/or save map and data plotting parameters to a file for sharing or for reuse.

Slices

Use this tab to plot a slice from a Voxel or 3D DXF, 3D Shapefile, or Geosoft Geosurface on a Plan or
Section map.

Creating a Section Plot
Section maps provide cross sectional views of drillhole traces, co-ordinates, reference grids, assay values and geological
units. Section maps represent an important tool that enables you to display drillhole traces to help establish subsurface
drilling coverage and visualize the geology and related geochemistry beneath the surface.
Before you can start creating your section maps you first must select the drillholes you want to view in your section.
The drillhole section plot options are provided in easy-to-use tab menus, enabling quick access to all the settings from a
single dialog. The dialog include sensible defaults; enabling easy creation of drillhole sections.
You can replot your Section map using the Replot Holes on Existing Plan or Section option, from the DH-Plot menu. This
option enables you to regenerate your current Section (or Plan) maps by simply replotting the holes without eliminating any
added groups, such as interpretations, images, or grids.
To Create a Section Plot:
1. On the DH-Plot menu, click Section.
The Section parameters dialog will appear.
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2. To specify the section location parameters, select the Section Location tab. Select the Location and Orientation,
Section Azimuth, Vertical Extent and Multiple Sections parameters, or accept the default values. Note that if you
select multiple sections each section will be displayed in individual maps. To plot multiple sections on a single map,
see the following Creating a Stacked Section Plot option.
To plot multiple sections on a single map, see the section.
3. You can edit the location coordinates either by specifying the values in the Easting Ref or Northing Ref boxes or by
clicking the Define button to interactively select the location coordinates from the plan map.
4. To plot a topography profile across the section, select the Topography tab and select the Plot topography on section
box to enable the topography parameters. Using the Browse button, locate and select the topography grid file to use
to calculate the topographic profile across the section. To edit the line style, click on the Line Style box beside the
grid file name.
5. To plot data along the hole traces in the section, select the Data tab.
The Plot boxes enable/disable the Data selection dropdown list. This is a convenient way to select or de-select
individual data plots, without clearing or re-selecting the data from the Data lists.
6. Select data channel(s) available in the drillhole project from the Data dropdown list. The selections combine the name
of the channel, along with the identifier for the component database in which the channel is found.
7. Using the Plot Type dropdown lists, select the plotting type for the data previously selected.
Select plot type(s) from the dropdown list. Plot types displayed are based on the data type of the selected Data.
Numeric channel selections include Bar plot, Grid: Kriging, Grid: Min curvature, Numeric bands, Post values, and
Profile. String or text channel selections include Comments, Post text, Rock code patterns, and Text bands.
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8. To specify the plan map window parameters, select the Plan View tab and select the Plot Plan View box. To enable
the plotting of a grid in the plan view window, select the Plot grid or image in plan view box. Using the Browse button,
locate and select the grid file to display.
9. To specify the profile window parameters, select the Profiles tab. To enable the plotting of a profile window, select
the Plot grid data profiles box. Using the Browse button, locate and select the grid file to use to calculate the profile
across the section.
The rectangle box to the right of the Browse button displays the selected Line Style. To edit the line style, click in
the box. The Line Attributes tool will appear.
10. To specify the page layout of the section plot, select the Page Layout tab. To specify the section map layout, click
the Map Layout button. The Section Map Layout dialog is displayed. This dialog enables you to specify the layout of
your section map. To accept the layout and return to the Page Layout tab, click the OK button.
11. To enable the title parameters check the Plot Titles box and add your titles content as required.
12. Click the OK button on the Section Parameters dialog. The section map is created and displayed.
There are many additional section-plotting options that enable you to include other parameters. As you become
more familiar with the system, we recommend that you experiment with the other options to create a custom map
of your own.

Creating a Stacked Section Plot
Drillhole stacked section option enables multiple sections to be plotted to the same map. The same tools for defining
multiple sections to individual maps are now available to plot the same sections to a single map.
To Create a Stacked Section Plot
1. On the DH-Plot menu, click Stacked Section.
The Section parameters dialog is displayed.
2. To specify the number of stacked sections to plot, select the Section Location tab. In the Number of sections box
under Multiple Sections, specify the number of sections you want plotted to a single map. Note that if you select
multiple sections all sections will be displayed on a single map. To create multiple sections on individual maps, see
the Creating a Section Plot section.
3. To plot data along the hole traces in the sections, select the Data tab.
The Plot boxes enable/disable the Data selection dropdown list. This is a convenient way to select or deselect individual data plots, without clearing or re-selecting the data from the Data lists.
4. Using the Data dropdown lists, select the data channels available in the current Drillhole project you want to plot.
5. Using the Plot Type dropdown lists, select the plotting type for the data selected.
Select plot type(s) from the dropdown list. Plot types displayed are based on the data type of the selected
Data. Numeric channel selections include Bar plot, Grid: Kriging, Grid: Min curvature, Numeric bands, Post
values, and Profile. String or text channel selections include Comments, Post text, Rock code patterns, and
Text bands.
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6. Click the OK button on the Section Parameters dialog. The stacked section map is created and displayed.
There are many additional section-plotting options that enable you to include other parameters. As you
become more familiar with the system, we recommend that you experiment with the other options to create a
custom map of your own.

Replot Holes on Existing Plan or Section
The Replot Holes on Existing Plan or Section option enables you to replot drillholes on a current Plan or Section map.
This option enables you to regenerate your current plan or section maps by simply replotting the holes, without eliminating
any groups that have been added in, such as interpretations, images, or grids.

Replot Holes on Existing Plan
The Replot Plan: Hole Parameters dialog includes the following tabs; Collars, Hole Traces, Data, Plan Grids, and Slices.
To Replot a Plan Map
1. Open and select (highlight) the Plan map to replot.
2. On the DH-Plot menu, select Replot Holes on Existing Plan or Section.
The Replot Plan – Hole Parameters dialog will appear. This tabbed dialog includes intelligent default values, including
the current Plan map parameters.
3. Once you have made your changes on the Replot Plan – Hole Parameters dialog, click the OK button.
The current Plan map will be replotted with the updated hole parameters, retaining any additional groups, such as
interpretations, grids or images.
4. For more information on the Replot Plan – Hole Parameters dialog, click the Help button on the tab of interest.

Replot Holes on Existing Section
The Replot Section: Hole Parameters dialog includes the following tabs; Collars, Hole Traces, Data, Topography, and
Slices.
To Replot a Section Map
1. Open and select (highlight) the Section map to replot.
2. On the DH-Plot menu, select Replot Holes on Existing Plan or Section.
The Replot Section – Hole Parameters dialog will appear. This tabbed dialog includes intelligent default values,
including the current Section map parameters.
3. Once you have made your changes on the Replot Section – Hole Parameters dialog, click the OK button.
The current Section map will be replotted with the updated hole parameters, retaining any additional groups, such as
interpretations, grids or images.
4. For more information on the Replot Section – Hole Parameters dialog, click the Help button on the tab of interest.
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